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About This Resource 
We live in an era in which we measure and monitor nearly every aspect of life. But what should we be doing 
with all these data? How can we begin to think about these data in a way that tells the story of the work we 
engage in every day? We need a way to see what is working well and also a way to discern when things are not. 

This resource organizes several indicators that measure career and college readiness (CCR) in order to inform 
school and district decision-making processes to improve outcomes for students and close achievement gaps. 
The information provided in this document will guide districts toward compiling and evaluating their own 
district-, school-, and student-level data in support of their accountability systems as well as their CCR goals. 

How to Access Data 

Time is always short, and the stakes are always high; therefore, this work must be intentional. Data help guide 
this process. Based on the Minnesota CCR Vision Workgroup principles, multiple forms of data which help to 
reflect a holistic picture of student competencies and preparedness are referenced in this section. Deciding what 
data to include in an evaluation and how to interpret the information is critically important. This resource also 
synthesizes Minnesota’s accountability systems to include a more coherent, high-level overview of indicators 
ranging from prekindergarten readiness data to social emotional measures and all the way to workforce 
outcomes such as Labor Market Information (LMI). 

This icon, found later in this document, will point the user to a state-level data set for that indicator. 
Directions are included on how to access and organize the data file. Please note that there may be a 
need to examine local data that are not available at the state level. 

Guiding Questions 

For each CCR indicator, a set of questions will guide you through each data set. Use these questions in staff 
and/or leadership meetings and throughout your school or district’s continuous improvement process. 

Inquiry Deeper Dive Action Items 

How should I interpret these data? 
These guiding questions will provide 
useful context and demonstrate how 
asking questions drives data inquiries, 
which can then generate further 
discussion and help either verify or 
disconfirm perspective. 

What else might I want to know? 
Because data in this evaluation 
offer only a high-level perspective, 
these questions offer 
recommendations for additional 
cuts of the data using either public 
or local district-level data. 

What’s next? 
This item hints at how to think 
about data through a CCR and 
continuous improvement lens. 

The Deeper Dive and Action Items questions in particular are intended to assist with continuous improvement 
efforts, your World’s Best Workforce goal setting, and your ESSA planning. 
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World’s Best Workforce: All Students Career and College Ready 
With the passage of the Every Student Succeeds Act (ESSA) in 2015, which reauthorizes the Elementary and 
Secondary Education Act, Minnesota has an opportunity to more closely align state and federal goals. Based on 
the synthesis of these two accountability systems, Minnesota now has one set of statewide goals. As such, 
statewide goals are what will be represented throughout the remainder of this document. 

The ESSA state plan establishes specific timelines for key measurements, which include third-grade reading, the 
closure of academic achievement gaps, eighth-grade mathematics (a very rough proxy for career and college 
readiness [CCR]), graduation, English learners’ progress toward English language proficiency, and consistent 
attendance. Our state World’s Best Workforce (WBWF) goals include third-grade reading, closing achievement 
gaps, CCR, and high school graduation. Together, the time bound statewide goals from our ESSA state plan 
represent significant progress toward the WBWF law’s longer-term goal of seeing all students (100 percent) 
succeed in these areas. Again, the synthesis of these two accountability systems is why all charts and graphs are 
marked with statewide goals. Minnesota uses a three-stage process to identify schools and districts for support, 
satisfying requirements from both ESSA and WBWF. More information is available on the Minnesota 
Department of Education (MDE) School and District Accountability webpage. 

If they choose, districts can use the statewide goals and measurements as a starting point for their own local 
goal setting and strategic planning, although districts are able to set local WBWF goals using other 
measurements and are not required to set goals according to the exact statewide goals listed in this document. 
This flexibility may be particularly meaningful when setting local goals and measures for CCR. 

As districts continue to identify and refine CCR goals within WBWF plans, consider the following questions: 

• How is the district defining and measuring CCR? 
• What data are available, how are they being used, and what else could be collected to measure CCR and 

inform continuous improvement?  
• How does the district’s evaluation process use data to inform how the district uses resources and 

manages processes? What strategies are in place to ensure equitable outcomes for all student groups? 
• What are the district’s goals and expectations for helping youth on their journeys to becoming career 

and college ready? What should all high school graduates know and be able to do? 
• What policies, structures, programs, and strategies will serve as pathways and supports to help high 

school graduates meet expectations? 
• How are the district’s performance indicator results being used to inform career development classroom 

instruction, career development activities offered, or the development of a quality, integrated K–12 
career development program? 

  

https://education.mn.gov/MDE/dse/account/
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State Accountability Goals and Measures 

The statewide goals set a high bar to close opportunity and achievement gaps. The system focuses on ensuring 
all students, including students with disabilities, students in poverty, English learners, students of color and 
American Indian students are successful. Districts and schools must continue to develop Career and College 
Readiness (which may include Career Technical Education), integrating their overall ESSA and WBWF systems, 
and improvement efforts.  

Minnesota’s statewide World’s Best Workforce and Every Student Succeeds Act Goals are displayed below. 

 

Data Inquiry: Where is your district’s performance at now? How might your district’s local WBWF goals be 
leveraged to reach the statewide goals within the timeframe specified? 

World’s Best Workforce long-term goals: 100% All students 
Note, districts are able to set their own local goals as they move toward the long-term 100% All Students 

• All students kindergarten ready 
• All students reading at third grade reading proficiency 
• All achievement gaps closed 
• All students career and college ready (CCR Goal is locally determined) 
• All students graduate. 

 

Statewide Goals by 2020 

• Four-year Graduation Rate (90%) 
• Consistent Attendance (95%) 

Statewide Goals by 2025 

• Third Grade Reading (90%) 
• Eighth Grade Math (90%) 
• EL students making progress (85%) 
• Achievement: All students above 85% 

  

https://education.mn.gov/MDE/dse/ccs/
https://education.mn.gov/MDE/dse/ccs/
https://education.mn.gov/MDE/dse/cte/index.htm
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CCR Goal Setting for WBWF 

Clearly defined, specific goals –when combined with a solid plan– give us a sense of purpose and direction. 
Establishing a meaningful goal-setting process with the deliverable product of specific goals can increase 
motivation, change behavior, and improve achievement. 

Clearly defined, specific goals developed in collaboration with a team of cross-system educators, administrators, 
students, community members, families, business partners, as well as other important stakeholders (ex. 
curriculum specialists, special education director, work-based learning coordinator, etc.) are much more likely  
to be achieved. In terms of a process, examining district needs assessment information and engaging in a data 
review process are recommended elements of collaborative goal setting. Districts track and discuss progress 
toward their goals on an annual basis; districts then submit a summary of their plan to MDE for feedback. 

The SMART (Specific and Strategic, Measurable, Attainable, Results-Based, and Time-Bound) criteria assist in 
setting clearly defined, specific CCR goals. For additional resources around goal-setting, see Setting Useful Goals 
Guide for World’s Best Workforce found on WBWF webpage. 

Example SMART Goals by CCR Domains 

Employability Skills Possible Data Source(s) 

One hundred percent of 10th-grade students will complete a resume 
highlighting their skills, qualities, and their career ready 
accomplishments by the end of their 10th grade school year. 

Reports from information 
systems software (LMS, MCIS, 
Naviance, etc.) 

One hundred percent of 11th-grade students will complete an essay 
(which could be used as a college application essay) highlighting their 
mindset as a learner by January 31st of their 11th-grade year. 

Course reports, reports from 
information systems software 
(LMS, MCIS, Naviance, etc.) 

One hundred percent of 8th-grade students will demonstrate 
competency in the information literacy standards (i.e., ISTE Student 
Standard 3: Knowledge Constructor) by the end of their 8th grade 
year. 

Course reports, student 
learning portfolio 

 

Mindsets and Social Awareness Possible Data Source(s) 

One hundred percent of 10th-grade students will review and updated 
their personal learning plan (PLP) Element 3 information (interests, 
aptitudes, and aspirations) prior to the end of their 10th grade year. 

Individual PLP plans, grade-
level reports 

Positive and supportive relationships will be fostered by decreasing 
peer-to-peer conflict from an incident rate of 10 percent down to 7 
percent for all 7th grade students by the end of the FY18-19 school 
year. 

Annual district Disciplinary 
Incident Reporting System 
(DIRS) data on assault, 
bullying, fighting, and 
harassment toward peer 

https://education.mn.gov/mdeprod/idcplg?IdcService=GET_FILE&dDocName=MDE074919&RevisionSelectionMethod=latestReleased&Rendition=primary
https://education.mn.gov/mdeprod/idcplg?IdcService=GET_FILE&dDocName=MDE074919&RevisionSelectionMethod=latestReleased&Rendition=primary
https://education.mn.gov/MDE/dse/wbwf/
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Mindsets and Social Awareness Possible Data Source(s) 

By the end of their 11th grade year (FY18), one hundred percent of 
11th-grade students will identify engagement in one or more 
career/community experience(s), such as participating in an 
extracurricular activity, club, or experiential learning opportunity (e.g., 
work-based learning, summer camp, community service, internships). 

11th-grade student survey, 
MCIS data 

The percentage of 11th-grade students participating in at least one 
school-sponsored or school-supported extracurricular activity will 
increase from 43 percent in 2018–19 to 55 percent in 2019–20. 

School level data such as MCIS 
PLP portfolio 

Career Development Possible Data Source(s) 

One hundred percent of 8th-grade students will complete all required 
PLP tasks by April of their 8th grade year (FY19). 

District-level reports within 
MCIS 

The percentage of high school students participating in a dual credit 
opportunity will increase from 35 percent in 2018–19 to 40 percent in 
2019–20. 

Dual credit enrollment data 

Eleventh-grade student enrollment in work-based learning or youth 
apprenticeship will increase from 8 percent completion in the 2018–19 
school year to 12 percent completion by the end of the 2019–20 
school year. 

Local data 

MDE Secure Reports: Perkins 
Summary reports 

Minnesota Common Course 
Catalog 

For the 2018–19 school year, 100 percent of 9th-grade students will 
participate in career-focused eMentoring experiences through the 
BestPrep Cloud Coach program. 

Local data 

PLP 

For the 2018–19 school year, the percentage of all students enrolled 
for one half year or more in Grades 6–8 who participate in two or 
more job shadowing experiences will increase from 66 percent to 75 
percent. 

Local data 

PLP 

For the 2018–19 school year, the percentage of all juniors and seniors 
placed in career pathway internships will increase from 4 percent to 
10 percent. 

Local data 

PLP 

For the 2018–19 school year, the percentage of high school students 
earning college credit through concurrent enrollment, dual credit, 
and/or Postsecondary Enrollment Options (PSEO) courses will increase 
from 11 percent to 20 percent. 

Participation data are 
available in SLEDS, Credit 
earned may be available at 
the local level depending on 
agreements  
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Transitional Knowledge Possible Data Source(s) 

Parent participation in at least one of three district workshops on 
financial aid will increase from 45 percent in 2018–19 to 75 percent in 
2019–20. 

Event registrations 

Enrollment in the Personal Finance course will increase from 30 
percent of 2018–19 juniors to 60 percent of 2019–20 juniors with a 
transition plan to enroll 100 percent of juniors starting in 2020–21. 

Course enrollments 

The number of Personal Finance students passing Technical Skill 
Assessments (TSA) for Banking Services or Securities and Investments 
will increase from 20 percent in 2018–19 to 60 percent in 2019–20. 

TSA reports 

The percentage of seniors receiving an individual career/college 
planning session with their counselor will increase from 80 percent in 
2018–19 to 100 percent in 2019–20. 

Counselor logs 

The percentage of seniors participating in a job shadowing experience 
in a career pathway field of interest will increase from 5 percent in 
2018–19 to 25 percent in 2019–20 with a transition plan to have 100 
percent participate by 2021–22. 

MDE Secure Reports, 
Summary Report: Course 

Work-Based Learning 
Coordinator logs 

Employer Evaluation of 
Student: Skills learned, Goals 
Met, Traits/Behaviors 

The percentage of all 12th grade students who have completed Free 
Application for Federal Student Aid (FAFSA) and/or scholarship 
applications, registered with a workforce center, or enlisted in the 
military at time of graduation will increase from 75 percent in 2018–19 
to 85 percent in 2019–20. 

Local data 

FAFSA Completion data from 
Office of Higher Education 

https://www.ohe.state.mn.us/mPg.cfm?pageID=2148
https://www.ohe.state.mn.us/mPg.cfm?pageID=2148
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Categories of CCR Data 
The process of measuring CCR and monitoring programs is not intuitive. When using data to tell the story of a 
school district, we often start at the “beginning” (usually pre-K through grade 3) and work forward through high 
school graduation. However, when thinking about data inquiry, it is important to consider the story in the 
opposite direction. That is, we start at the end goal to look at existing student outcomes and then work 
backward. For example, what do schools and districts want student outcomes to look like in high school? And 
how do we get there? What needs to happen earlier in the system in order to academically prepare students for 
eventual careers? CCR data can be categorized into five main “buckets” that tie back to the CCR Domains and 
Competencies. These data inform CCR programming and guide decision making. 

Social-Emotional Learning 

Social-emotional learning (SEL) is broadly understood as a process through which people 
build awareness and skills in managing emotions, setting goals, establishing relationships, 
and making responsible decisions that support their success in school and in life. SEL develops competencies 
that foster positive social skills, reduce conduct problems, diminish emotional stress, and improve academic and 
career performance. As the benefits of SEL become more salient, so, too, do the measures now available to 
assess SEL competencies and implementation. Districts are encouraged to identify assessments to measure and 
monitor SEL data at the local level. These data are not reported to the state. 

Career Readiness 

Career readiness indicators represent pre-K through grade 12 activities, 
curricula, and events that raise awareness and provide opportunities for 
students to explore and experience a variety of career options. It is important to ensure that all students have 
equitable access to relevant knowledge and skills across a variety of career possibilities. These activities help 
students connect and engage with people in their field of interest, develop social-emotional skills, and access 
leadership opportunities that will support them in a healthy work environment once they enter the job market. 

Academic Performance 

Academic performance indicators primarily include summative assessments and 
represent the final outcome of all the work and effort that has gone into learning the 
knowledge, skills, and abilities that will assist students in transitioning to career and college opportunities. 

Additional Relevant Data 

These data can be collected to inform your CCR programming. These data represent work and activities which 
may have happened before and after the K–12 system.  
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Continuous Improvement 

Continuous improvement data are important at every grade 
level across the pre-K through grade 12 system. Continuous 
improvement data and indicators represent a variety of formative assessments plus ongoing progress 
monitoring activities, curricula, targeted services, program evaluations (which may include formative and 
summative data), as well as support programs that ultimately assist students toward achieving their highest 
level of academic challenge and move students closer to their career goals. These data are typically maintained 
at the local level and are not included within this document. However, these data often represent the bulk of 
the ongoing work within a district. Please refer to the Minnesota Department of Education’s continuous 
improvement resources school program planning level or overall district strategic planning. 

  

https://education.mn.gov/MDE/dse/cimp/
https://education.mn.gov/MDE/dse/cimp/
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Continuous Improvement Data for Career and College Readiness 
The chart below lists local and state data sets and indicators that can be used in either a locally defined or the 
state developed resource for a continuous improvement process to measure, assess, plan for and monitor 
career and college readiness. 

 

 

https://education.mn.gov/MDE/dse/cimp/
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State-Level Data Sources by Type 

The information provided within this resource includes data examples to guide districts toward compiling and 
monitoring their own district-, school-, and student-level data in support of CCR goals. Data referenced within 
this section are: interactive and mobile friendly, available to download, and special permission required. All 
types referenced here include state agency sources. 

MDE’s Outreach and Data Interpretation page contains additional support regarding various data reports that 
are available. This site provides teachers with easy access to data and resources to inform their instruction. 

To access the data sources listed below, visit MDE’s home page and select “Data Center” on the top 
navigation bar: MDE Homepage > Data Center. Choose from the following: 

Interactive and Mobile Friendly 

Early Childhood Longitudinal Data System (ECLDS) is an innovative tool that combines birth through 12th-grade 
data collected by the Minnesota Departments of Education, Human Services, and Health into one interactive 
database. Educators can begin to ask questions to gauge the effectiveness of current programs and design 
targeted improvement strategies to support students, families, and communities. 

Minnesota Report Card gives easy access to understandable district and school data. This interactive tool is 
designed to provide parents, educators, schools, districts, and citizens with easy access to district and school 
information, test results, demographic information, and other critical data in a centralized location. A variety of 
filters are available to help drill down district- and school-level data. Please note that Minnesota Comprehensive 
Assessments (MCA)/Minnesota Test of Academic Skills (MTAS) results displayed on the Minnesota Report Card 
represent all students—regardless of graduation status. 

The Statewide Longitudinal Education Data System (SLEDS) matches student data from prekindergarten through 
completion of postsecondary education and into the workforce. Educators can begin to ask questions to gauge 
the effectiveness of current programs and design targeted improvement strategies to help students. SLEDS 
combines data from the Minnesota Department of Education, Office of Higher Education, and Department of 
Employment and Economic Development into one interactive website. Reports displayed on this site address 
course-taking patterns during high school, high school achievement and ACT results, postsecondary enrollment, 
developmental education demographics, and some workforce data. Please note that SLEDS displays outcomes 
only for those students who have graduated. 

The Minnesota Department of Employment and Economic Development (DEED) exists to promote business 
recruitment, expansion, and retention as well as to foster workforce and community development. This website 
provides a number of data tools and analytics that are helpful for job seekers, career planning, and business and 
industry. DEED’s Labor Market Information (LMI) can be compiled by region. These data are critical when 
planning for local education, training, and workforce needs. 

  

https://education.mn.gov/MDE/dse/inst/
https://education.mn.gov/mde/index.html
http://eclds.mn.gov/
http://rc.education.state.mn.us/
http://sleds.mn.gov/
https://mn.gov/deed/
https://mn.gov/deed/data/regional-lmi/
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Available to Download 

Data Reports and Analytics lists data files that are publicly available often at the state, region, district, and 
school levels. These summary data provide information about districts, schools, and student demographics. A 
sampling of files that are available on this site include attendance, enrollment, discipline, and graduation rate. 
Data sets can be filtered specific to users’ needs. Data can be downloaded as an Excel file or in portable 
document format (PDF). 

Special Permission Required 

Secure Reports are data files and analytics available to only authorized users who have requested and been 
given access to specific files or sections. For example, districts can request access for data such as Carl Perkins 
Secure Reports (that is, Career Technical Education [CTE]) data, school improvement assessment reports 
(MCA/MTAS contrast groups, free or reduced-price lunch [FRPL] eligibility), and early learning information, 
among many other data sources. Different divisions at MDE hold responsibility for allowing access to individual 
sections. 

http://w20.education.state.mn.us/MDEAnalytics/Data.jsp
http://w20.education.state.mn.us/MDEAnalytics/DataSecure.jsp
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CCR Data Indicators at a Glance 
Below is a quick at a glance snapshot of the CCR Data described in this report including data source(s). Each 
Category title in the table is hyperlinked to a later section within this document where additional information is 
provided. The District/School Data column indicates data collected and maintained at a local level; local data are 
not displayed on any public-facing state report or website. The State Data column represents data that the state 
maintains and displays. 

Aspirational Statewide goals are provided for any indicator that is part of either state or federal accountability 
reporting. Again, the aspirational goal for WBWF is “all students” (i.e., 100 percent) and a demonstration of 
progress toward locally determined WBWF goals, while ESSA contains time-bound expectations around 
measures that were determined in collaboration with statewide stakeholder groups. 

Social Emotional Learning 

Category Data Indicators (applicable grade levels) District/School 
Data State Data 

SEL Competencies District-determined SEL assessment X n/a 

Career Readiness 

Category Data Indicators (applicable grade levels) District/School 
Data State Data 

Career Awareness 
and Exploration Career-focused field trips, guest speakers, curricula (PK–12) X n/a 

Career Awareness and 
Exploration 

Career interest inventories and surveys (7–12) X n/a 

Career Awareness and 
Exploration 

Documentation of Personal Learning Plan activities (9–12) X n/a 

Career Awareness and 
Exploration 

Participation in student organizations, leadership 
opportunities, and competitions (9–12) 

X n/a 

Career Awareness and 
Exploration 

Recognition and awards received (9–12) X n/a 

Course-Taking 
Patterns Enrollment in CTE courses (7–12) X Secure 

Reports 
Course Taking Patterns Enrollment in honors courses (7–12) X n/a 
Course Taking Patterns Number of CTE concentrators (9–12) X Secure 

Reports 
Course Taking Patterns Enrollment in rigorous courses: PSEO, concurrent 

enrollment, Advanced Placement (AP), and International 
Baccalaureate (IB) (9–12) 

X SLEDS 

Career 
Development Participation in Youth Apprenticeships (11–12) X Secure 

Reports 

https://education.mn.gov/mdeprod/idcplg?IdcService=GET_FILE&dDocName=MDE073770&RevisionSelectionMethod=latestReleased&Rendition=primary
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Category Data Indicators (applicable grade levels) District/School 
Data State Data 

Career Development Participation in Work-Based Learning (11-12) X Secure 
Reports 

Career Development Industry Recognized Credentials earned (9-12) X n/a 
Career Development Armed Services Vocational Aptitude Battery (ASVAB) score 

(10-12) 
X n/a 

Career Development Students who took TSA in approved CTE programs, by 
content area (9–12) 

X Secure 
Reports 

Academic Performance 

Category Data Indicators (applicable grade levels) District/School 
Data State Data 

Kindergarten 
Readiness 

Statewide goal: All students (100 percent) meeting 
school readiness goals 

Families accessing early care and education (Birth-K) 
n/a 

ECLDS 

Kindergarten Readiness Participation by program (Birth-K) n/a ECLDS 

Consistent 
Attendance 

Statewide Goal: 95 percent of students will consistently 
attend with no student group below 95 percent 
attendance, by 2020 

Students consistently attending (data displayed by: grade 
(1–12), and by student group) 

X Secure 
Reports 

Disciplinary 
Actions 

Disciplinary actions (data displayed by: grade (K–12), by 
gender, and by ethnicity) X Data Reports 

and Analytics 

Progress Toward 
English Language 
Proficiency 

Statewide Goal: 85 percent of English learners will be 
making progress in achieving English language 
proficiency, by 2025 

ACCESS/Alt-ACCESS: Average progress toward EL 
proficiency (otherwise known as, Index (grades 1-12)) 

X Minnesota 
Report Card 

Reading 
Achievement 

Statewide Goal: 90 percent of all students will score 
proficient or higher in reading by third grade, by 2025 

Statewide Goal: 90 percent of all student will be 
proficient in reading, by 2025 

Statewide Goal: No student group below 85 percent ; at 
least 85 percent of students in every student group are 
proficient, by 2025 

MCA/MTAS, Meets/Exceeds Proficiency (data displayed 
by: grade, by gender, and by student groups (3–8, 10) 

X 

Minnesota 
Report Card 
and Secure 
Reports 
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Category Data Indicators (applicable grade levels) District/School 
Data State Data 

Math 
Achievement 

Statewide Goal: 90 percent of all student will be 
proficient in reading, by 2025  

Statewide Goal: No student group below 85 percent; at 
least 85 percent of students in every student group are 
proficient, by 2025 

MCA/MTAS, Meets/Exceeds proficiency (data displayed 
by: grade, by gender, and by student groups (3–8, 11)). 

n/a 

Minnesota 
Report Card 
and Secure 
Reports 

High School 
Performance 

Participation in Advanced Placement and International 
Baccalaureate exams (9-12) [Note: AP/IB Course and 
Exam Participation as well as Exam Performance data are 
available in SLEDS, though only the AP/IB Exam 
Participation chart is displayed in this report] 

X SLEDS 

High School Performance MCA career and college readiness goal score (10, 11) X SLEDS 

High School Performance ACT score X n/a 

High School Performance Postsecondary credits earned X n/a 

Four-Year 
Graduation Rate 

Statewide Goal: 90 percent of high school student will 
graduate in four years, by 2020 

Statewide Goal: No student group below 85 percent 
graduating in four years, by 2020 

Four-Year Graduation Rate 

X 
Minnesota 
Report Card 
and SLEDS 

Additional Relevant Data  

Category Data Indicators (applicable grade levels) District/School 
Data State Data 

College 
Performance Enrollment in developmental education n/a SLEDS 
College Performance Postsecondary enrollment n/a SLEDS 
College Performance Highest undergraduate degree completed n/a SLEDS 

Work Force 
Development Labor Market Information by region n/a DEED 
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CCR Indicators 
This section provides background information and context for each CCR indicator. Each section links 
to a corresponding example chart, which is displayed later in the document. 

Social Emotional Learning 

The most impactful SEL implementation begins during early education (PK–3) and is consistently implemented 
throughout a student’s educational experience (until graduation). Effective SEL implementation requires districts 
to use a strategic, systemic approach involving everyone from district and school leaders to community partners 
and families. Everyone needs to work together at all levels to ensure that students receive the support they 
need. Successful SEL implementation is not achieved through a stand-alone program or an add-on lesson; it 
must be a central part of how schools, communities, and families value and support the social, emotional, and 
academic development of their children. 

As the benefits of SEL become more salient, so, too, do the measures now available to assess SEL competencies 
and implementation. These data are not reported to the state; however, districts are encouraged to identify 
assessments to measure and monitor SEL data at the local level. MDE staff have synthesized information on 
available assessments to think about prior to implementing SEL, and compiled a list of further SEL resources. 

Career Readiness 

Career Awareness and Exploration 

The goal of these activities is to expose students to career options and assist them with finding and maintaining 
the appropriate level of academic and career interest. No state-level data are available. Please refer to the CCR 
Domains and Competencies section for career awareness and exploration activities tied to the CCR domains and 
competencies. 

Course-Taking Patterns 

These data look at participation in CTE courses and programs as well as participation in rigorous courses such as 
Postsecondary Enrollment Options (PSEO), Concurrent Enrollment, Advanced Placement (AP), and International 
Baccalaureate (IB). Access state level data on course-taking patterns. 

http://education.state.mn.us/mdeprod/idcplg?IdcService=GET_FILE&dDocName=MDE073520&RevisionSelectionMethod=latestReleased&Rendition=primary
http://education.state.mn.us/mdeprod/idcplg?IdcService=GET_FILE&dDocName=MDE073521&RevisionSelectionMethod=latestReleased&Rendition=primary
http://education.state.mn.us/mdeprod/idcplg?IdcService=GET_FILE&dDocName=MDE073521&RevisionSelectionMethod=latestReleased&Rendition=primary
https://education.mn.gov/MDE/MDE073503
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Career Development 

Youth Apprenticeship Participation 

Youth Apprenticeship is a paid experience for 11th- and 12th-grade students. The Youth Apprenticeship requires 
a written agreement and training plan. For a one-year program, the training plan includes 450 hours of work-site 
learning and 120 hours of related classroom instruction; a two-year program includes 900 hours of work-site 
learning and 360 hours of related classroom instruction. Students are paid by their employer. Youth Apprentice 
may or may not provide postsecondary credit and/or industry-recognized credential(s). 

Industry-Recognized Credentials Earned 

These certifications verify mastery of, or competency in, specific knowledge, skills, or processes that can be 
measured against industry standards. These certificates are valuable to employers because they allow them to 
determine the skill or education level of applicants. 

Armed Services Vocational Aptitude Battery Scores 

ASVAB is a multiple-aptitude assessment battery that measures developed abilities and assists in predicting 
future academic and occupational success in the military as well as providing career exploration tools, and an 
interest assessment. This battery of assessments provides a means to identify, select, and place individuals 
interested in serving in any of the six branches of the military and/or whose goal is a military career. These 
assessments are offered to American high school students in 10th through 12th grade, although anyone eligible 
may take the assessment. 

Technical Skill Assessments Participation 

Technical Skill Assessments (TSA) are state-approved standardized assessments that are aligned to national 
industry standards; many are industry certifications. These assessments are often given to students who 
participate in approved CTE programs and courses. Results from TSA are sent either to the high school principal 
or directly to the teacher of record. These data are then submitted to MDE as part of the accountability 
measures for Perkins/CTE. Local data may have more detail available. Access state level data on TSA 
participation. 

Academic Performance 

Kindergarten Readiness 

Statewide Goal: All students (100 percent) meeting Kindergarten Readiness goals. 

CCR begins at birth and continues on through the high school years and beyond. High-quality early childhood 
education programs can provide a strong foundation on which to build future success in school and career. The 
Minnesota K–12 Academic Standards are the foundation of the K–12 system; similarly, the Early Childhood 
Indicators of Progress (ECIPs) are the foundation of the PK–3 system. ECIPs and the Kindergarten Academic 

http://www.minnstate.edu/system/cte/programs/mntsa.html


CCR Resource Guide: Data Inquiry 17 

Standards are aligned, resulting in a system that has Academic Standards from birth through 12th grade. Keep in 
mind, though, that learning outcomes and data may look very different within the early years. 

Districts are encouraged to examine their early childhood screening data, which could be used for WBWF Goal 1 
with the goal generally being to increase the number of children who are screened between their third and 
fourth birthday. Additional goals could include increasing preschool and kindergarten participation, as well as 
monitoring the programs and services students and families are accessing; there are many possible WBWF goals 
and strategies that districts could implement. 

District administrators are encouraged to connect with early childhood professionals both inside and outside of 
their district. A wealth of data and information exists but might be best known by their early learning 
professionals, who may include early childhood family education coordinators, early childhood coordinators, 
voluntary prekindergarten, school readiness, and school readiness plus program administrators, as well as lead 
prekindergarten and kindergarten teachers. Access state level data on kindergarten readiness. 

Consistent Attendance 

Statewide Goal: 95 percent of all Minnesota students will consistently attend school by the year 2020, with no 
student group below 90 percent. 

In general, students who attend school consistently are more likely to develop early literacy skills, graduate from 
high school on time, and succeed in pursuit of their career and college goals post high school. This trend is likely 
to be strongest when a school provides effective academic instruction, an all-around positive school climate, and 
the ability to address students’ social, emotional, and physical health needs. Access state level data on 
consistent attendance. 

Disciplinary Actions 

Although not directly included as an accountability measure, note that in most cases when a student is 
suspended, the suspension is counted as an absence. Access state level data on disciplinary actions. 

Progress Toward English Language Proficiency 

Statewide Goal: 85 percent of all English Learners will make progress in achieving English language proficiency 
by the year 2025. 

An English Learner (EL) is defined in Minnesota as “a pupil in kindergarten through grade 12 or a 
prekindergarten student enrolled in an approved voluntary prekindergarten program under Minnesota Statutes, 
section 124D.151 or a school readiness plus program who meets the requirements under subdivision 2a or the 
following requirements: 

(1) The pupil, as declared by a parent or guardian has a home language other than English; and 
(2) the pupil is determined by a valid assessment measuring the pupil’s English language proficiency and by 

developmentally appropriate measure, which might include observations, teacher judgement, parent 
recommendations , or developmentally appropriate assessment instrumentation, to lack the necessary 

https://education.mn.gov/mdeprod/idcplg?IdcService=GET_FILE&dDocName=MDE058473&RevisionSelectionMethod=latestReleased&Rendition=primary
https://education.mn.gov/mdeprod/idcplg?IdcService=GET_FILE&dDocName=MDE058473&RevisionSelectionMethod=latestReleased&Rendition=primary
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English skills to participate fully in academic classes taught in English.” (2017 Minnesota Statutes, 
section 124D.59, subdivision 2). 

Students with Limited or Interrupted Formal Education (SLIFE) make up a specific group of English Learners. This 
includes “an English Learner with an interrupted formal education who:  

(1) comes from a home where the language usually spoken is other than English, or usually speaks a 
language other than English;

(2) enters school in the United States after grade six;
(3) has at least two years less schooling than the English learner’s peers;
(4) functions at least two years below expected grade level in reading and mathematics; and,
(5) may be preliterate in the English Learner’s native language.” (2017 Minnesota Statutes, section 

124D.59, subdivision 2a). 

Minnesota has adopted the World-class Instructional Design and Assessment English Language Development 
(WIDA ELC) standards. These standards reflect the social and academic language expectations of ELs in grades 
pre-K through 12 attending schools in the United States. The focus is on providing a language instruction 
educational program that ensures language growth in listening, speaking, reading, and writing. 

The annual state English language proficiency assessment, based on the ELD standards, is called Assessing 
Comprehension and Communication in English State-to-State (ACCESS). The ACCESS 2.0 assessment has six 
levels of proficiency. In Minnesota, a student is considered proficient if they score at least 4.5 and three out of 
four domain scores (in listening, speaking, reading and writing) of at least 3.5. When a student meets 
proficiency, the student must be excited from the Language Instruction Education Program (LIEP) and 
reclassified in MARSS at the beginning of the following school year. If a student has not met the ACCESS 
proficiency score, the student should continue with LIEP. Access state level data on progress toward English 
language proficiency. 

Reading Achievement 

Statewide Goal: 90 percent of all Minnesota students will score proficient or higher in reading by third grade, 
with no student group below 85 percent by 2025. 

Statewide Goal: 90 percent of all Minnesota students will be proficient in reading by the year 2025, with no 
student group below 85 percent. 

As outlined in WBWF, the Reading Well by 3rd grade goal is all students 100 percent proficient by no later than 
the end of students’ third-grade year; and, more broadly, then to maintain proficiency across all subsequent 
grades. However, districts are able to determine their own aspirational goals as they progress toward 100 
percent proficiency.  

In regard to the Reading MCA-III, test items are directly aligned to the Academic Standards and assess both the 
content and rigor of the standards. It is important to review the changes in rigor across grade levels. Changes in 
complexity across grade levels can be seen within the various components of the Test Specifications (Lexile, 
Word Count, etc.). It is expected that as grade levels increase, associated reading skills also become more in-

https://www.wida.us/standards/eld.aspx
https://education.mn.gov/MDE/dse/stds/ela/
https://education.mn.gov/MDE/dse/stds/
https://education.mn.gov/MDE/dse/test/spec/
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depth, complex, and comprehensive. Thus, the MCA-III assessment follows a typical pattern of skill development 
across the grades, and the standards must be addressed accordingly within each grade level. 

Both WBWF and ESSA highlight closing all racial and economic gaps between students as priority work. The 
importance of this work can be seen throughout the CCR data. For example, gaps that are not closed within PK–
12 tend to persist into postsecondary enrollment as well as careers. Additional student groups to monitor for 
achievement gaps include gender, economically disadvantaged or FRPL eligible, English learner, special 
education, and the associated contrast groups. Access state level data on reading achievement. 

Math Achievement 

Statewide Goal: 90 percent of all Minnesota students will score proficient or higher in math by eighth grade, 
with no student group below 85 percent by 2025. 

 Statewide Goal: 90 percent of all Minnesota students will be proficient in math by the year 2025, with no 
student group below 85 percent. 

The Math MCA-III test items are directly aligned to the Minnesota K-12 Academic Standards in Mathematics and 
assess both the content and rigor of the standards. Districts are encouraged to review information in the Math 
Benchmark Toolkit, which enables district leadership and school staff to review their curriculum maps, make 
adjustments in the areas that are causing the most difficulty, and ensure that classroom teachers are equipped 
to provide learning experiences that enable all students to successfully meet the standards. 

The Achievement Level Descriptors can be used to provide information regarding grade-level expectations and 
coherence across the grades. It is very difficult to understand the rigor of the standards at a particular grade 
level without knowing the standards and benchmarks at least one year below and one year above the grade 
level. When teachers review the information in this guide, they often recognize the impact of their particular 
interpretation of their standards and are better able to focus their instruction. 

Although WBWF highlights eighth-grade math proficiency as a CCR indicator, a variety of measures mentioned 
throughout the CCR Resource could be used to indicate a student’s progress toward CCR. 

Both WBWF and ESSA highlight closing all racial and economic achievement gaps between students as priority 
work. The importance of this work can be seen all throughout the CCR data. For example, gaps that are not 
closed within pre-K through grade 12 tend to persist into postsecondary and later career potential. Additional 
student groups to monitor for achievement gaps include gender, economically disadvantaged or FRPL eligible, 
English learner, special education, and the associated contrast groups. See MDE's Secure Reports: Accountability 
Secure Reports. Access state level data on math achievement. 

  

https://education.mn.gov/MDE/dse/wbwf/
https://education.mn.gov/MDE/dse/ESSA/mnstp/
https://education.mn.gov/MDE/dse/stds/Math/index.htm
https://education.mn.gov/MDE/dse/stds/Math/MDE034563
https://education.mn.gov/MDE/dse/stds/Math/MDE034563
https://education.mn.gov/MDE/dse/test/ald/
https://education.mn.gov/MDE/dse/wbwf/
https://education.mn.gov/MDE/dse/ESSA/mnstp/
http://w20.education.state.mn.us/MDEAnalytics/DataSecure.jsp
http://w20.education.state.mn.us/MDEAnalytics/DataSecure.jsp
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High School Performance 

AP and IB Exam Participation 

Advanced Placement (AP) exams are open to all students, not just those who have taken an AP course, so home-
schooled, online students, and others may take an AP exam for credit. Students who complete an AP course 
and/or take the end-of-course examination may qualify for college credits from postsecondary institutions, 
provided their score meets the institution’s credit policy. Students should check with individual postsecondary 
institutions for the most current list of the AP courses each institution accepts for postsecondary credit. An 
outcome of three or higher is considered passing for an AP assessment. 

International Baccalaureate (IB) exams are open only to students who have first participated in the associated IB 
course. An outcome of four or higher is considered passing for an IB exam. Access state level data on AP and IB 
exam participation. 

MCA Career and College Readiness Goal Score (MCA-CCR) 

Minnesota Statutes, section 120B.30, prohibits a Minnesota State college or university from requiring a student 
to take a developmental education course in a subject area if the student has received an MCA score that meets 
or exceeds the career- and college-ready benchmark in that subject area. 

Depending on local agreements, Minnesota’s testing contractor, Pearson, sends the Individual Student Reports 
(ISRs) to principals, school counselors, or directly to the student’s home. Typically, these results are sent out in 
August. 

Included on the ISR is a CCR goal score, which is an indicator that the student’s performance is on track to 
demonstrate CCR on a college entrance exam by the end of grade 11. Scores falling below the CCR goal score 
may indicate that a student’s performance is not on track to meet CCR goals. CCR goal scores are reports only 
for reading and math. Please see the Interpretive Guide for Minnesota Assessment Reports for additional 
information on how to interpret this section of the ISR document, posted on MDE’s Statewide Testing site. 

ACT Score 

ACT acceptance scores vary widely by college of enrollment. Low ACT scores are one reason students can be 
placed into developmental education. Students in developmental education had an average ACT score of 17.0; 
students not in developmental education had an average ACT score of 23.0. 

Minnesota State colleges and universities are required by state law to exempt students from ACCUPLACER 
testing and place them into college-level courses if they present ACT English, reading, and/or mathematics 
scores that meet or exceed the ACT college-readiness benchmarks. Access state level data on ACT scores.. At the 
local level, districts may also have data on student SAT scores. 

  

https://education.mn.gov/MDE/fam/dual/AP/
http://sleds.mn.gov/
http://sleds.mn.gov/
https://education.mn.gov/mdeprod/idcplg?IdcService=GET_FILE&dDocName=MDE071820&RevisionSelectionMethod=latestReleased&Rendition=primary
https://education.mn.gov/MDE/dse/test/
http://www.act.org/content/act/en/college-and-career-readiness/benchmarks.html
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Postsecondary Credits Earned 

These data are not available at the state level. The state reports enrollment trends but does not have access to 
completion or credit-earned information. Districts that have local access to these data are encouraged to 
organize, review, and monitor this information to ensure equitable access and that opportunities are being 
maximized. 

Four-Year Graduation Rate 

Statewide Goal: 90 percent of all Minnesota students will graduate in four years by the year 2020, with no 
student group below 85 percent. 

For the purposes of ESSA accountability, this indicator will use a school’s four-year and seven-year graduation 
rate. Students are counted at the school they last attended, with the exception of those students who drop out 
after less than half an academic year. Students with less than .5 ADM are counted at the high school they 
attended for the greatest amount of time. Access state level data on four-year graduation rates. 
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Additional Relevant Data 

College Performance 

Although students have left the pre-K through grade 12 system at this point in the data, it is important to 
examine this information for clues and patterns that might inform career and college readiness programming 
throughout the earlier years. Keep in mind that the data displayed within SLEDS analytics include only those 
students who have graduated high school. For example, MCA scores may appear inflated within SLEDS as 
compared with outcomes displayed within MDE Report Card (which contains information on all students). 
Additionally, this is the reason why only the number of students graduating high school is presented in the first 
box of the data chart, as opposed to a percentage. 

New reports are being added all the time to the SLEDS analytics site. Therefore, it is important to consider where 
you would like to start a data inquiry and the questions you would like answered. The college performance chart 
within this document provides one example of how to begin thinking about and organizing SLEDS data for your 
district. For example, the percent of students enrolling in Developmental Education refers back to the MCA-CCR 
goal score (described above) and whether students are academically prepared for college-level coursework. Also 
important to consider is not only the percent of students enrolling in postsecondary, but also whether students 
are enrolling in a two-year or four-year institution. Often patterns in enrollment can indicate financial 
opportunities, transition programs, and/or strong relationships between secondary and postsecondary as much 
as it reflects students’ interests and program offerings. 

The final piece of information included in the chart is the highest undergraduate degree completed. Students 
who are both academically prepared for college-level work and who have a good sense of career interests stand 
a much better chance of completing their desired program. 

Workforce Development 

Conducting a data inquiry with information provided on DEED’s website is helpful for several reason. First, 
knowing the trends in the job market as well as what jobs may be currently be available can be very helpful in 
discussing career development information with students and families. Additionally, knowing the employers 
within a given area can assist in connecting pre-K through grade 12 programs with business and industry 
partners who may be able to provide information on the latest industry innovations and alignment with 
curriculum. Finally, knowing the DEED data can assist in informing the need for new programs or perhaps even 
expanding existing programs based on local economies and employment potential. Please see DEEDS data 
website for a range of data tools and resources.  

https://mn.gov/deed/data/data-tools/
https://mn.gov/deed/data/data-tools/
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Data Handbook 
This section of the CCR Resource is more technical in nature. This section is not intended to be read front to back 
like a book, but, instead to be used as a guidepost or example in order to compile data, produce charts, and 
inform continuous improvement efforts. Information in this section could easily be delegated across a team of 
people or used in conjunction with existing local resources. However, for those who are starting with this 
section or were assigned one or two specific charts to create, please read the corresponding information in the 
previous sections for background knowledge and context. 

The “Data Visualization How-To Guide” contains step-by-step directions for creating a chart in a variety of 
formats for those folks who have not created a chart before. Links to videos are embedded for anyone who 
might want to see a general example of the steps carried out in real time. A list of data indicators and the 
corresponding example chart types are provided. 

Next is the “State Level Data and Guiding Questions.” Information within this section contains the exact same 
elements for each data indicator represented in this resource. Each data indicator contains the following 
information: 

1. Breadcrumb trail – lists the exact steps to take in order to find the data file and provides any additional 
detail that might be helpful once the file has been downloaded or is viewed. 

2. Example chart – is designed to include a pre-K through grade 12 perspective wherever possible along 
with the Statewide Goal for that indicator. 

3. Data Inquiry box – lists the questions the example chart is addressing and provides any additional 
information or caveats that might exist relative to interpreting the data. 

4. Deeper Dive box – provides additional follow-up questions once the initial example graph has been 
produced using local district data. Given that the data for each indicator is often the result of a year’s 
worth of effort, one “cut” of the data is often not enough to fully understand what is currently being 
implemented, the degree to which something is being implemented, and the results that are happening 
for any given group of students or the system as a whole. Therefore, these questions are intended to 
lead folks toward further investigations or “data cuts” in order to make informed decisions about the 
work prior to determining what actions may need to be taken in order to see improvement in student or 
school outcomes. 

5. Action Items box – provides additional thoughts to consider as you work through district data and 
consider the school and community needs. Wherever possible, direct links to MDE resources are 
imbedded so that if interventions, resources, or additional information is needed around a particular 
data indicator, those resources can be found efficiently. 
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Data Visualization How-To Guide 

How to Build Data Visualizations in Excel provides tips on how to make any data set visually engaging. 

Possible divide-and-conquer strategy: 

1. Staff create charts in whatever software or web environment works best (Tip: Word/Excel create better 
overall quality charts). 

2. Charts are copied/pasted from the various sources into one “Master Copy” document that all staff can 
access and which is maintained on a local share drive, in Google Docs, or other web-based application. 

3. Leadership team(s) and/or Career and College Ready workgroups meet to discuss the findings of the 
data inquiry and determine an appropriate course of action for the purpose of continuous improvement. 

Prior to using Google Sheets or other web-based applications, please check your district’s contract with these 
entities and/or local policy. The level of data privacy available within Google Docs/Sheets or other web-based 
applications may vary across districts. Best practice is not to include any student identifiable data within a 
system that stores data outside your own district/state server, in which case the data may not then belong to 
the district/state, or that other entities might then be able to access and use at their discretion. If only summary 
data and outcomes are used, such as the data used to complete the charts represented in the CCR Handbook, 
then it is at the discretion of each district and their local policies whether to use Google Docs/Sheets or other 
web-based applications to develop and store charts for data inquiry. 

Basic Chart Types included in this section 
Chart 

Chart Type Data Indicator: Chart Example Software 

A. Pie Chart Kindergarten Readiness (percentage of Families and 
Students accessing Early Care and Education) 

Excel, Word, 
Google Sheets 

B. 2-D Clustered Column Consistent Attendance (by grade) 

Discipline 

Kindergarten Readiness (participation by program type) 

Math Achievement (by grade) 

Reading Achievement (by grade) 

Rigorous Course Exam (participation) 

Rigorous Course-Taking 

Excel, Word, 
Google Sheets 

C. 2-D Bar Consistent Attendance (by student group) 

Technical Skill Assessments 

Excel, Word, 
Google Sheets 

D. Stacked Bar CTE Participants and Concentrators (by Career Field) Excel, Word, 
Google Sheets 

http://stephanieevergreen.com/how-to/
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Chart 
Chart Type Data Indicator: Chart Example Software 

E. Stacked Column ACCESS 2.0 English Learners Excel, Word, 
Google Sheets 

F. Overlapping Bars ACT Composite Scores 

Four-year Graduation Rate 

Excel and Word 

G. Vertical Dumbbell-dot-plot All Gap analysis Excel and Word 

Microsoft Word 

Follow these steps for charts types A-E. 

1. In Word, Insert > Chart 
2. Select the chart type you would like to create (see list above). Do not create 3D charts of any kind, ever. 
3. Once you select “Ok” to insert the chart, Word will bring up a dialog box that looks similar to an Excel 

worksheet. The highlighted section is where you will enter in the data. 
a. Category represents distinct categories of data (ex., Work-Based Learning, Agriculture, Business, 

etc.). Series represents the numbers or percentages you would like to see represented on the 
chart (ex., number of students, outcome percentages, etc.). 

4. If the pop-up box accidentally closes, do not worry. To edit the data, right click on the chart, then select 
“Edit Data in Excel.” 

5. To change the look of the graph, double-clicking will bring up formatting options along the right side of 
the screen. 

a. Tip: keep the scale consistently at 100 percent whenever possible (Max 1.0); however, if/when 
you need to decrease the scale, be sure to display the (vertical Y-axis) scale on the graph for 
transparency in reporting. 

b. Tip: Double-clicking any element on the chart, then selecting “delete”, will delete that element 
(select “undo” to bring it back). 

6. Additional options for changing the look of the graph can be found (when clicking once to select the 
chart) under Chart Tools > Design or Format. These options help to expedite updates. 

a. Tip: For a cleaner look, selecting the green Plus sign that pops up along the right side of the 
chart can be a quick way to uncheck/remove the Primary Horizontal gridlines. 

7. If you would like to get a general sense of what this process looks like, you can watch How to make a 
Column (Vertical Bar) Graph in Microsoft Word (1:39) or How to insert and edit a chart in Word 2016 
(6:02 minutes). MDE does not support or sponsor any advertisements shown while watching this video 
nor endorse any particular person or company which may be represented. Please do not use any of the 
glow or 3D features covered in the video. If additional assistance is needed, you may be able to access 
Lynda Learning training videos through your local library. 

8. Save file every step of the way. 

 

https://www.youtube.com/watch?v=Gxcbkv6FA_g
https://www.youtube.com/watch?v=Gxcbkv6FA_g
https://www.youtube.com/watch?v=LBO0uCWWWKg


CCR Resource Guide: Data Inquiry 26 

Microsoft Excel 

Follow these steps for chart types A-E. 

1. In Excel, input your data. 
2. Highlight the data > Insert > Charts (column/bar chart symbol) > select the chart you want from the 

drop-down menu. 
3. Follow steps 5-6 and 8-9 in the Word section (above) for how to change the appearance of a chart. 
4. If you would like to get a general sense of what this process looks like, you can watch How to Create a 

Column Chart in Excel 2016 (3:40). MDE does not support or sponsor any advertisements shown while 
watching this video nor endorse any particular person or company which may be represented. If 
additional assistance is needed, you may be able to access Lynda Learning training videos through your 
local library. 

Google Sheets 

Follow these steps for charts type A-E. 

1. From Google Drive, Sheets or Select File > new > spreadsheet > Name the file. 
2. Input the data. 
3. Highlight the data, select Insert > Chart –a default chart will appear. 
4. Use the “Customize” tab in the Chart Editor to change the chart type if needed; for example, to remove 

the legend or gridlines, to adjust the scale (vertical axis), and/or to include Data Labels or change the 
color of the bars (double-click on the chart to bring this up if it is not already shown). 

5. No need to save the file because as soon as you name it, the file is saved to the cloud. 
6. Select “Insert” along the top ribbon, then, “New Sheet” to add another worksheet/chart to the same file 

(or, select the + sign located at the bottom left corner of the sheet), otherwise copy/paste the chart into 
the shared document where all charts will live. 

7. If you would like a general sense of what this process looks like, you can watch How to Make a Bar 
Graph using Google Drive (4:44). An older version is displayed in the video, but, the process is very 
similar. How to Create a Bar Graph | Google Docs Tutorial provides a high-level overview of the steps 
(1:08). MDE does not support or sponsor any advertisements shown while watching these videos nor 
endorse any particular person or company which may be represented. If additional assistance is needed, 
you may be able to access Lynda Learning training videos through your local library. 

  

https://www.youtube.com/watch?v=SqGq8c1yZ-4
https://www.youtube.com/watch?v=SqGq8c1yZ-4
https://www.youtube.com/watch?v=bkSCoyZJHfg
https://www.youtube.com/watch?v=bkSCoyZJHfg
https://www.youtube.com/watch?v=XWpjGzhWKpw
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Overlapping Bars in Word/Excel 

Follow these steps for chart type F. Access visuals for these steps. Note: MDE does not endorse any one person 
or company. There may be many resources; this website is the resource used here. 

1. In Excel, input the data (note: there should be two columns for each category of data). 
2. Highlight the data > Insert > Charts (chart symbol) > clustered bar chart. 
3. Click once to select the set of bars you want in front. 
4. Right-click and select Format Data Series > select the radio button next to Secondary Axis (note: this may 

appear to “hide” one set of bars, that is ok). 
5. Make sure the secondary axis at the top of the chart matches the axis at the bottom of the chart. If it 

does, select the axis and the top of the chart > delete, it is redundant. 
6. Select the bars that are in back > increase Gap Width by sliding the bar to the left. 
7. Click once to select a set of bars > Format Data Series (to the left of the screen) > Paint bucket icon > Fill 

and Border allow for personalization of the bar colors according to school colors, or any colors of your 
choosing. Tip: Choose wisely, sunglasses should not be needed to review data inquiry graphs. 

8. Save file every step of the way. 
9. Optional: Insert > Shapes > Line > left hold mouse and move to the right to draw a line > click and drag 

to place the line on the graph where you want it. Drawing Tools > Shape Outline > Dashes in order to 
create a dashed line across the target percentage the district is aiming to achieve. 

Vertical Dumbbell-dot-plot in Word/Excel 

Follow these steps for chart type F. Access visuals for these steps. MDE does not endorse any one person or 
company. There may be many resources; this website is the resource used here. 

1. In Excel, input the data. Below is a snapshot of what the data structure looks like for the FY2017 Reading 
achievement gap chart. Grades are listed as column headings, rows represent the various student 
groups you are interested in reviewing, fill in the percent proficient (meets/exceeds) accordingly. 

 
2. Highlight data > Insert > 2-D Line with Markers. 
3. Double-click the scale along the left > Format Axis > Maximum 1.0 > Enter. 
4. Click once to select the scale > Delete. 
5. Click once to select the horizontal gridlines > Delete. 
6. Click once to select the markers on one line > Format Data Series > Paint bucket icon > Line > select No 

line > Marker > Marker Options > Built-in > Size 10 > Fill (select color) > Border (select matching color). 
7. Repeat step 6 for each of the lines in the chart. 
8. Chart tools (top ribbon) > Design tab > Add Chart element (top left on ribbon) > Lines > High-Low lines. 
9. Click once to select the category titles > Home tab > Font (adjust to preferred type and size).  

http://stephanieevergreen.com/overlapping-bars/
http://stephanieevergreen.com/overlapping-bars/
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State-Level Data and Guiding Questions 

Course-Taking Patterns 

Career and Technical Education (CTE) Participation 

MDE > Secure Reports > Carl Perkins Secure Reports > CTE Participation 

Note: This report will soon be available for authorized users. Until then, districts are encouraged to 
review their own local course enrollment data. 

 

Example interpretation: approximately 75 percent of high school students (52,653/70,202) attained the status of 
either CTE Participant or CTE Concentrator by their 12th-grade year (FY 2017). 
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Rigorous Course Participation 

MDE > Data Center > Statewide Longitudinal Data System (SLEDS) > Rigorous Course Taking > 
Rigorous Course Enrollment (Filter for: year, student group, program) 

 

 

Inquiry: CTE/AP/IB/CE/PSEO Deeper Dive Action Items 

How many 12th-graders 
successfully completed 100–239 
course hours within one career 
field of a CTE program 
(Participants = 29,521)? 

How many 12th-graders 
successfully completed 240 course 
hours or more within one career 
field of an approved CTE program 
(Concentrators = 23,132)? 

How many graduates enrolled in: 
Advanced Placement (AP), 
International Baccalaureate (IB), 
Concurrent Enrollment, and/or 
Postsecondary Enrollment Options 
(PSEO)? 

Is the participation of the various 
student groups taking courses in 
different career areas 
representative of your school 
population? 

How can student interests be 
capitalized to further engage 
students and develop additional 
course offerings? 

Do all students have access to 
these courses (disaggregated data 
by student group)? 

Do local school schedules support 
opportunities for students to more 
deeply develop career skills in 
their area of interest? 

Are program areas connecting 
with local business and industry 
partners in order to evolve and 
align programs and curriculum? 

Are the right CTE programs in 
place that align with 
postsecondary as well as local 
business and industry needs? After 
identifying the root cause for why 
students may or may not be 
consistently attending, the next 
step is to identify additional 
resources and strategies for 
continuous improvement. 

 

https://education.mn.gov/MDE/fam/dual/AP/
https://education.mn.gov/MDE/fam/dual/ib/
https://education.mn.gov/MDE/fam/dual/ce/
https://education.mn.gov/MDE/fam/dual/pseo/
https://education.mn.gov/MDE/dse/cte/progApp/
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Career Development 

Technical Skill Assessment (TSA) Participation 

MDE > Data Center > Secure Reports > Carl Perkins Reports > P-File Submission Status (Filter for: 
district and year) 

 

Seventy-one percent (5,443/7,667) of students who took a TSA assessment in FY 2017 were proficient. Trade 
and industry programs offer more TSAs than any other program area. 

Inquiry Deeper Dive Action Items 

How many 9th- through 12th-
grade students took the TSA? 

What was the overall TSA 
proficiency rate for the state? 

What are the TSA outcomes by 
student group? 

What TSAs/certifications are 
valued by local business and 
industry partners? 

Are there any other approved CTE 
programs or courses that could 
offer the TSA and/or industry 
certification? 

When was the last curriculum 
review conducted? 

Are the appropriate TSAs being 
offered relative to the curriculum 
being implemented? 

Are TSA outcomes being used to 
inform/modify/update/validate 
local instruction? 
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Kindergarten Readiness 

Data do not include private-pay childcare and preschool arrangements, or data sources not committed to 
integrating into the ECLDS system. 

MDE > ECLDS, Early Childhood Longitudinal Data System (Report: Kindergarteners > Early Care & 
Education > Participation in Public Early Care and Education) 

 

MDE > ECLDS, Early Childhood Longitudinal Data System (Report: Kindergarteners > Early Care & 
Education > Participation by Program) 
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Inquiry Deeper Dive Action Items 

How many students were known 
to have participated in early care 
and education (ECE) 
opportunities? 

What programs are students and 
families accessing? 

Were there any specific programs 
that appear to have a higher rate 
of participation? 

Does the student population 
enrolled in early childhood 
education represent the diversity 
of the district? 

Are students participating in only 
one program, or are students and 
families accessing multiple 
programs? 

Examine local census data to 
determine whether there are any 
families/communities not 
currently accessing existing 
programs and who could benefit 
from the services. Determine 
what/if any additional barriers to 
participation might exist. 
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Consistent Attendance 

MDE > Data Center > Secure Reports > Accountability Secure Report > Consistent Attendance Roster 
Downloads (Percent students consistently attending by grade: Data Detail tab: Columns AE and AF, 
will need to aggregate in order to report grade level information; Percentage Students Consistently 
Attending, by Student group: used the Accountability Summary tab: Columns H, I, and J) 
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CCR Resource Guide: Data Inquiry 35 

 

Inquiry Deeper Dive Action Items 

Of students enrolled for at least half 
a school year, how many attended 
more than 90 percent of the time? 

Note that attendance is a necessary, 
but by no means sufficient, 
condition for students to benefit 
from their experience of school. 

Are there any grades or student 
groups that appear to have a lower 
level of attendance? 

Are there any adult actions that 
could address or influence the 
reasons students are chronically 
absent? 

How might the reasons for chronic 
absence also be affecting 
achievement and graduation? 

After identifying the root cause for 
why students may or may not be 
consistently attending, the next step 
is to identify additional resources 
and strategies for continuous 
improvement, such as recognizing 
good attendance, engaging students 
and parents, developing 
personalized and early outreach, 
and/or developing systemic 
programmatic responses to provide 
support and reduce barriers. For 
more information, please visit 
MDE’s Implementing ESSA website. 

  

https://education.mn.gov/MDE/dse/ESSA/Imp/MDE072612
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Disciplinary Actions 

MDE > Data Center > Data Reports and Analytics (Student Data, Discipline Data, Report List=Counts 
by grade/gender/All Students by Race/Ethnicity). Note a new MN Report Card discipline report will be 

available beginning FY19. For the most recent and detailed information see MDE > Districts Schools & Educators 
> Business & Finance > Data Submissions > Disciplinary Incident Reporting System (NOTE: access to this report is 
determined by the district). 
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Note: Students of Color (SOC) include data from Asian, Hispanic, Hawaiian/Pacific Islanders, and multi-ethnic 
student groups. 

Inquiry Deeper Dive Action Items 

Is there a particular grade band, 
gender, or student group that has 
a higher rate of disciplinary 
incidents resulting in actions? 

Are there any particular incidents 
that occur at a higher rate than 
others? 

Do the student(s) with the highest 
incident rate engaged in school 
have a good relationship with at 
least one trusted adult, and/or feel 
safe in their environment? 

For a deeper dive into school 
climate, engagement, and safety, 
visit the most recent Minnesota 
Student Survey Reports 2013-16. 
To go beyond identifying negative 
student behaviors and begin to 
identify student assets, see also 
current research conducted using 
data from the Minnesota Student 
Survey. 

Is it time to rethink discipline as a 
strategy toward improving school 
climate? 

Are alternatives to suspension 
being implemented system-wide? 

Do current interventions, or 
restorative practices, allow 
students to be held accountable 
for their own actions? 

How are teachers being supported 
in this process? Is there a district 
team trained in the Minnesota 
Early Indicator and Response 
System (MEIRS)? 

  

http://w20.education.state.mn.us/MDEAnalytics/DataTopic.jsp?TOPICID=242
http://w20.education.state.mn.us/MDEAnalytics/DataTopic.jsp?TOPICID=242
https://sites.google.com/view/mnydrg/research
https://sites.google.com/view/mnydrg/research
https://sites.google.com/view/mnydrg/research
https://education.mn.gov/MDE/fam/disc/
https://education.mn.gov/MDE/dse/sped/alt/index.htm
https://education.mn.gov/MDE/dse/safe/clim/prac/
https://education.mn.gov/MDE/dse/drop/MEIRS/
https://education.mn.gov/MDE/dse/drop/MEIRS/
https://education.mn.gov/MDE/dse/drop/MEIRS/
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Progress Toward English Language Proficiency 

For Program Improvement: MDE > Data Center > Minnesota Report Card > ACCESS for ELLs (Filter by: 
grade, student groups, composite or domain). Option 2: MDE > Data Center > Secure Reports > 

Assessment Secure Reports: Test Result Summary > (Default: Test=Access, Subject=Composite, Year=2018, 
Grade=All Grades, Gender=All Students, Race/Ethnicity=All Students, Category=All Students); report on percent 
by level for Overall ACCESS for ELL’s (as a place to start). 

 

For Accountability (high-level overview): MDE > Data Center > Secure Reports > Accountability Secure Reports: 
North Star Report > Filters: District=your district, School=All Schools, Reporting year=most recent, Overall 
Average of Groups=No, Race/Ethnicity=All Students, Category=All Students > Run Report. 

For Accountability (includes grade level information): MDE > Data Center > Secure Reports > Progress Toward 
English Language Proficiency Roster > compile the average of all “Accountability Index” points (Column AN) by 
“Grade” (Column P). 
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Inquiry Deeper Dive Action Items 

Program Improvement: What are 
the achievement level distribution 
for ACCESS Composite scores by 
grade in school? 

Accountability: What is the overall 
average student progress toward 
target for your school (Index)? 

How large is your English Learner 
population? 

How many languages are 
represented? 

What are student scores on: 
Comprehension, Literacy, and Oral 
Language? Disaggregated by 
SLIFE? 

Read the English Learner 
Education in Minnesota Report for 
additional definitions and data 
details. 

Do you know the identification 
and exit procedures? 

https://education.mn.gov/mdeprod/idcplg?IdcService=GET_FILE&dDocName=MDE035523&RevisionSelectionMethod=latestReleased&Rendition=primary
https://education.mn.gov/mdeprod/idcplg?IdcService=GET_FILE&dDocName=MDE035523&RevisionSelectionMethod=latestReleased&Rendition=primary
https://education.mn.gov/MDE/dse/el/
https://education.mn.gov/MDE/dse/el/
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Reading Achievement 

MDE > Secure Reports > Accountability Academic Roster > Academic Achievement Summary tab 
(note: Subject (Column F) displays M=Math, R=Reading) > record Column K “Academic Achievement 
Rate” > also look at “Include in average” (Column L) which indicates whether the group is included in 

the accountability calculations (Y) or not (N) (note: there must be at least 20 students within a group in order to 
be included in the calculation). 

Currently available, but, may not be much longer: Data Center > Assessment and Growth Files > Filter for: 
MCA or MTAS (these are separate in this file), Public/Non, and Subject. Then, insert a new column and either 
add columns Z+AA, or use this equation where the letter represent the columns (V+W)/S. 

 

For a high-level overview, see also: MDE > Data Center > Secure Reports > *North Star Report 
(*note: does not contain grade level data) 
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Inquiry Deeper Dive Action Items 

What percentage of students 
met/exceeded proficiency on the 
MCA/MTAS assessments (all 
students, by grade)? 

Which grades, gender, and other 
student group(s) tend to have 
disparities? 

Are the three-year trends within a 
grade/student group increasing or 
decreasing? 

What additional data are collected 
at the local level to help monitor 
skill attainment and identify 
students in need of additional 
services? 

How are students identified for 
interventions or additional 
services? 

Are there gaps in the alignment of 
the curriculum to the standards 
and benchmarks? 

How do teachers record progress 
toward standards and 
benchmarks? 

What collaborative structures are 
in place to support adult learning? 

Do students receive instruction on 
all the benchmarks before the 
MCA-III is given? 

How are core content and CTE 
teachers partnering to align 
technical reading concepts as well 
as coordinate learning 
experiences? 

What would the district need to do 
to start an American Indian 
education program if one does not 
already exist? 

Is a local literacy plan in place? 

Where challenges exist, how are 
parents being informed and 
included in the student’s learning 
process? 

  

https://education.mn.gov/MDE/dse/fsce/mod/Eng/index.htm
https://education.mn.gov/MDE/dse/fsce/mod/Eng/index.htm
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Math Achievement 

MDE > Secure Reports > Accountability Academic Roster > Academic Achievement Summary tab 
(note: Subject (Column F) displays M=Math, R=Reading) > record Column K “Academic Achievement 
Rate” > also look at “Include in average” (Column L) which indicates whether the group is included in 

the accountability calculations (Y) or not (N) (note: there must be at least 20 students within a group in order to 
be included in the calculation). 

Currently available, but, may not be much longer: Data Center > Assessment and Growth Files > Filter for: 
MCA or MTAS (these are separate in this file), Public/Non, and Subject. Then, insert a new column and either 
add columns Z+AA, or use this equation where the letter represent the columns (V+W)/S. 

 

For a high-level overview, see also: MDE > Data Center > Secure Reports > *North Star Report 
(*notes: does not contain grade level data) 
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Inquiry Deeper Dive Action Items 

What percentage of students 
met/exceeded proficiency on the 
MCA/MTAS assessments (all 
students, by grade)? 

What grades, gender, and other 
student group(s) tend to have 
higher disparities? 

Is there sufficient attention to 
mathematical problem solving, 
representations, and reasoning, or 
do learning experiences and 
common assessments emphasize 
skills and factual recall? 

What additional data are collected 
at the local level to monitor 
achievement, and how are these 
data used to motivate changes in 
instructional practices? 

Are beliefs about mathematics or 
beliefs about learners causing 
lower expectations, a narrower 
curriculum, or remedial tracks? 

Does district/school benchmark 
report data mirror what is 
happening in classrooms? 

Are there gaps in the alignment of 
the curriculum to the standards 
and benchmarks? 

How do teachers record progress 
toward standards and 
benchmarks? Do students receive 
instruction on all the benchmarks 
before the MCA-III is given? 

How are core content and CTE 
teachers partnering to align 
vocabulary and concepts as well as 
coordinate learning experiences? 

What collaborative structures are 
in place to support adult learning 
of mathematics content, learning 
trajectories, and instructional 
responses to student thinking? 
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High School Performance 

AP and IB Exam Participation 

MDE > Data Center > Statewide Longitudinal Data System (SLEDS) > Rigorous Course Taking > 
Rigorous Course Exams (Filter for: year, student group, program) 

Inquiry Deeper Dive Action Items 

How many graduates participated 
in an AP or IB exam? 

Additional exam data are available 
within the Rigorous Course-Taking 
Report, which provides exam 
participation and outcome data 
disaggregated by race/ethnicity 
and economic students groups. 
This information is available at the 
state, district, and school levels 
(within Appendices B and C). 

How are students invited to 
participate in honors courses, 
starting in grades 7–8? 

How are candidate students (who 
could be successful in an AP/IB 
course with assistance) being 
invited to participate? 

Are parents being notified of their 
learner’s potential? 

Are students aware of the 
opportunity for college credit if 
they pass an AP exam (3+) or IB 
exam (4+)? 

http://sleds.mn.gov/
https://education.mn.gov/MDE/about/rule/leg/rpt/2018Reports/
https://education.mn.gov/MDE/about/rule/leg/rpt/2018Reports/
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ACT Score 

MDE > Data Center > Statewide Longitudinal Data System (SLEDS) > “High School Graduates” High 
School Academics > ACT Mean Composite Score (Filter for: year and student group) 

Inquiry Deeper Dive Action Items 

Of those students who graduated 
in 2016, what were their average 
composite ACT scores? 

What are the scores for English, 
math, science, and reading?  

For each disaggregated student 
group? 

For students who have taken two 
or more credits in world 
languages, arts, CTE, and physical 
education? 

What percentage of graduates 
from your district enroll in 
postsecondary? 

Two-year institution? 

Four-year institution? 

Are ACT prep opportunities made 
available to students? 

Are parents and students aware of 
the ACT Benchmarks? 

http://www.act.org/content/act/en/college-and-career-readiness/benchmarks.html
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Four-Year Graduation Rate 

MDE > Data Center > Secure Reports > Graduation Rate Roster > Accountability Summary > Percent 
Graduating (Column K), note: also look at “Include in Average” (Column L) which indicates whether 
the group is included in the accountability calculations (Y) or not (N) (note: there must be at least 20 

students within a group in order to be included in the calculation). For a high-level overview, see also: MDE > 
Data Center > Secure Reports > *North Star Report (*does not include grade level information). 

Inquiry Deeper Dive Action Items 

What is the FY2017 four-year 
graduation rate for each student 
group as compared with the all-
student rate? 

What does scheduling look like? 
Are students in a position where 
they make course choices based 
on interests that then cause them 
to delay graduation? 

Where (if at all) are students losing 
credits? 

Do you have a CTE program in 
place that assist students toward 
their career interests and goals? 

Are students engaged? Safe? 

Are families/community involved? 

Conduct a needs assessment 
including local employer needs, 
family/community perceptions, 
and student interests. Are the 
right programs in place? Could 
existing programs be enhanced? 

Developing strong collaborations 
between schools, families, and 
communities is an essential for 
students’ academic success. 

https://education.mn.gov/MDE/dse/fsce/
https://education.mn.gov/MDE/dse/fsce/
https://education.mn.gov/MDE/dse/fsce/
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College Performance 

MDE > Data Center > Statewide Longitudinal Data System (SLEDS) (Filter for: year, student group, 
program) 

Note: The heading in each box under “SLEDS” is the name of the report. 
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Interpretation Deeper Dive Action Items 

How many graduates enrolled in a 
postsecondary institution the first 
semester after graduation? 

Of those, how many enrolled in 
developmental education courses? 

What percentage of the students 
who initially enrolled earned a 
certificate (while in enrolled) or 
degree at any point during the last 
seven years? 

Finally, what certification or 
degree did students earn? 

What were students’ course-taking 
patterns in high school? 

Did those academic choices 
prepare students for the rigor of 
postsecondary courses and 
support students’ career 
potential? (Course Taking and 
Rigorous Course Taking reports in 
SLEDS, can also use the CTE/Non-
CTE filter.) 

What does this pattern of results 
look like for your district? Are 
students initially entering into 
two-year or four-year 
postsecondary institutions? 

What are the top 25 colleges 
attended by students from your 
district? 

What can secondary instructional 
and administrative leadership do 
to support CCR systems and data 
teams? 

Does your district have a 
communication plan for WBWF 
and CCR teams to work across 
grade bands? 

Additional resources to better 
position students for future 
success can be found at Career 
and College Success. 

 

https://education.mn.gov/MDE/dse/ccs/
https://education.mn.gov/MDE/dse/ccs/
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